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Description 

Your drawings contain a potential gold mine of information. But are you getting the most out of 
them? In this class, you'll learn to dig deep into your drawings using the powerful Data 
Extraction tool. You'll learn how to easily extract golden nuggets of data, and then easily reuse 
that data in a variety of ways. Together, we'll build automated Index to Drawings sheets and 
coordinate tables. We’ll even combine AutoCAD data and Microsoft Excel data to unleash the 
power of your AutoCAD DWG™ files. 
 

Speaker(s) 

Ben Rand has been using AutoCAD software since Release 12. He learned to program using 
LISP in AutoCAD, worked his way up through VBA, VB6 and VB.NET, and now spends most of 
his days programming in C# (occasionally still in AutoCAD!). He has worked in the Industrial 
Engineering field for more than 17 years as a CAD Manager, developer and IT Director. In 
2013, he was the 2013 Top DAUG overall winner at AU, and he served a mentor for the 
AutoCAD Mentor All-Star team. Ben is the proud father of four children and enjoys reading and 
playing a variety of sports including pickleball, volleyball, and tennis. In 2018, Ben was a 
member of a USTA men's league tennis team that won a national title and another team that 
was the finalist. 
 
 

 

 
 

Learning Objectives 

• Learn how to create tables and text labels in AutoCAD based on drawing data 

• Learn how to extract data across multiple drawing files 

• Learn how to link Excel spreadsheets with AutoCAD data 

• Learn how to customize data extraction using sorting, filtering, formulas, and totals 
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Introduction  

We all know that our drawings are valuable tools used to convey information about our design to 
other people so that what we design can be built. Some of this information is easy enough to 
read by looking at dimensions and other annotations on the drawing. 
 
But there’s a lot of other information lurking beneath the surface, including block attribute data, 
as well as all sorts of geometric information. In this lab, we’ll be exploring how the powerful Data 
Extraction tool can help you be more efficient, productive and accurate. 

Lab Data Set 
Files for the lab are located in C:\DATASETS\Ben Rand\AS197578-L. Be sure and open 
Handout.pdf file which contains all the instructions for the exercises. 
 
As we go through the exercises, I’ll demonstrate each exercise for the class, explaining some of 
the details, then let you go to work. Please watch the demo so you get the gist of where the 
exercise is headed. Don’t try to keep up while I do the demo—I’m going to work fast so you’ll 
have time to work! I’ve tried my best to make the handout very detailed. If you get lost, raise 
your hand and one of my lab assistants or I will be happy to help you. 
 

Creating tables and text labels in AutoCAD based on drawing data 

We’ll start with an architectural example, using Floor Plan Sample.dwg. In this drawing, we have a 

floor plan of one floor of an office building. The plan includes offices, cubicles, and other rooms, 
and identifies where major furniture (desks, chairs, etc) are located along with standard office 
equipment such as phones and computers. 
 

Exercise #1: Adding Text Labels Linked to Object Properties 
 
In this exercise, we’re going to place some “tile” hatch in the restrooms, then add a text 
annotation that calculates the square footage for us automatically. Open the Floor Plan 
Sample.dwg. I’m assuming in the instructions below that you know how to create layers, and 
hatch areas, so I’ll only provide detail in those areas when I want something specific. I’ll be more 
detailed when we get to how we’re going to extract data to create the annotations. 
 

TIP: If you need assistance during the exercise, signal one of the lab assistants or me and 
we’ll be happy to help you. 

 
1. Locate the two restroom areas located below the elevator lobby (room 6001) and to the left 

of the “Printer Island”. 
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FIGURE 1 RESTROOM AREA FOR HATCHING 

 

2. Use the LAYFRZ command  then select either of the restroom doors to freeze the E-F-
Door layer. 

3. Use Layer Properties to create a new layer  named “Tile”, color 101, and set current. 
 

 
FIGURE 2 ADDING A NEW LAYER FOR THE TILE 

 

4. On the Home tab, locate the Draw panel, then click the HATCH button . 
5. Select pattern ANSI37 and set the scale to 120. 
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FIGURE 3 HATCH SETTINGS FOR TILE 

 
6. Pick a point inside either of the restrooms—but not both! 
7. Click Close Hatch Creation or press Enter (or the Space Bar) to end the command. 
8. Repeat steps 5-8 to hatch the other restroom. 
 

 
FIGURE 4 TILE HATCHED RESTROOMS 

 
9. On the Home tab, locate the Annotation panel, then click the Text button. 
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FIGURE 5 ANNOTATION PANEL 

 
10. Draw a box approximately as shown below. 
 

 
Figure 6 Text Box Boundaries 

11. Type “TILE: “ then right-click in the text box and choose Insert Field to open the Field 
dialog box. 

 

FIGURE 7 INSERTING A FIELD INTO AN ANNOTATION 

 
12. Under Field Category, choose Objects. 
13. Under Field Names, choose Object. 

14. Next to Object type, click the Select Object button . 
 

TIP: These annotations could easily go in paperspace as well. When it comes time to 
select objects, AutoCAD “sees” modelspace entities right through viewports, so as long 
as it’s visible through a viewport, you can select the target object. 

 
15. In the drawing, select either of the hatch objects. 
16. Under Property, select Area. 
17. Under Format, select Architectural. 
18. Under Precision, select 0.00. 
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FIGURE 8 FIELD SETTINGS FOR HATCH OBJECT 

 
19. Click OK. 
20. On the Text Editor tab, locate the Style panel, then click the Mask button. 
 

 
FIGURE 9 MASK BUTTON 

 
21. Check Use background mask and Use drawing background color, then click OK. 
22. Click Close Text Editor on the ribbon tab. 
23. If necessary, adjust the text box size by selecting it and using the grips. 
24. Repeat steps 10-24 to add another annotation for the other restroom. 
 

TIP: You can copy the previous annotation, then double-click to edit it. Right-click the 
field portion and choose Edit Field. You can then select the other restroom hatch, and 
verify all the settings. Once you’ve closed the text editor, the new annotation should 
show the other restroom’s tile area. 
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FIGURE 10 LINKED ANNOTATIONS 

 
This is very useful. And because the fields are linked to the hatch’s area property, any change 
to the hatch area is automatically reflected in the text annotations! Easy…and accurate. 
 

Exercise #2: Creating a Furniture Report 

In this exercise, we’ll take our first look at the Data Extraction tool to find out how much furniture 
is in the plan. 
 
1. Open the Floor Plan Sample.dwg file located in the lab files folder. 
2. Zoom in to the upper left area of the drawing. 
3. Turn on Quick Properties if it’s not on already (the button turns blue). 
 

TIP: The Quick Properties button  is located on the status bar. If you can’t see it, you 

may need to add it by clicking the Customization button  at the far right end of the 
status bar, then checking Quick Properties. 

 

 
FIGURE 11 TURNING ON QUICK PROPERTIES 
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4. Select a few of the blocks representing office furniture. You’ll see the names of several 
blocks such as FNPHONE, CHAIR7, COMPUTER, and DESK3. 

 

 
FIGURE 12 SELECT BLOCKS TO SEE QUICK PROPERTIES 

 
You have a decision to make here. Do you want the table (report) to be in model space, or on a 
layout? I prefer most of my annotations to go on a layout as it’s easier to deal with text height 
and other considerations. 
 
5. Select the Layout1 tab1 in the lower left corner of the drawing area. 
6. On the Ribbon, click the Insert tab, and locate the Linking & Extracting panel. 
7. Click the Extract Data button. 
 

 
FIGURE 13 EXTRACT DATA COMMAND 

 
8. Select Create a new data extraction, then click Next. 
 

                                                

1 If the Model and Layout tabs are not displayed, use the OPTIONS command > Display > Layout 
Elements, and check Display Layout and Model tabs. 
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FIGURE 14 DATA EXTRACTION 1: NEW OR EXISTING DXE? 

 
9. Select a folder and file name for your DXE file, I’ll name mine FurnitureTakeOff.dxe. 
 

TIP: When you use the Data Extraction command, you’ll either be creating a new file, or 
editing an existing one. This DXE file is separate from the drawing (or drawings!) from 
which the data is to be extracted. It’s an important file that needs to be preserved along 
with the DWG files, so typically save these files in the same folder as your DWG files. 

 
10. Click Save to move to the next step. 
 
By default, AutoCAD includes the current drawing as the Data source, but you can also include 
other drawings, using the Add Folder or Add Drawings button. We’ll explore these options later 
in the lab. 
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FIGURE 15 DATA EXTRACTION 2: WHICH DRAWINGS? 

  
11. Verify that Include current drawing is checked, then click Next. 
12. In step 3, right-click the list of objects detected in the drawing and choose Uncheck all. 
13. Check Chair7, Computer, Desk2, Desk3, FC15X27A, FC42X18D and FNPHONE.  
 

 
FIGURE 16 DATA EXTRACTION 3: WHICH OBJECTS? 

 
14. In step 4, uncheck the Layer property, then right-click and choose Invert Selection. Only 

the Layer property should be checked. 
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FIGURE 17 DATA EXTRACTION 5: WHICH PROPERTIES? 

 
TIP: The Invert Selection technique can really save you a lot of clicks when you only want 
a few properties—which is generally the case. 

 
For this report, we don’t really want the layer name in our output, but the wizard forces us to 
choose something. We’ll hide this in the next step as we’re really after the block names, and the 
count of items found in the drawing. 
 
15. Click Next. 
 

WARNING: This sample drawing includes some non-uniformly scaled blocks, which 
AutoCAD will warn you about. Just click OK and proceed with the wizard. 

 
16. In step 5, right-click the Layer column and choose Hide column.  
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FIGURE 18 DATA EXTRACTION 5: WHAT COLUMNS AND SETTINGS? 

 
17. Drag the Name column to the left of the Count column.  
 

TIP: It’s difficult to see but if you look carefully, you’ll see a blue bar appear to the left of 
the Count column when you’ve dragged the Name column far enough. Release the 
mouse button when you see the blue bar. I enlarged the screenshot below so you can 
(hopefully) see it better. 

 

 
FIGURE 19 REARRANGE COLUMNS USING DRAG AND DROP 

 
18. Click on the Name column to sort on that column. 
19. Be sure that Combine identical rows, Show count column and Show name column are 

all checked. 
 

 
FIGURE 20 DATA EXTRACTION 5 (CONTINUED) 

 

20. Click Next. 
21. In Step 6, check the Insert data extraction table into drawing check box. 
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FIGURE 21 DATA EXTRACTION 6: WHERE TO OUTPUT TO? 

 
22. Click Next. 
23. In Step 7, enter the title FURNITURE TAKE-OFF. 
 

 
FIGURE 22 DATA EXTRACTION 7: WHICH TABLE STYLE SETTINGS? 

 
24. Click Next. 
25. Click Finish, then pick an insertion point somewhere in the drawing. 
 

TIP: If you get this far and realize, “Oh no! I’m still on the Model tab!” All is not lost. Just 
hit ESC to cancel inserting the table. Switch to Layout1 and start Extract Data again. 
Choose the Edit option in step 1, then locate the DXE file which has been created. Click 
Next all the way through the wizard, as all the settings are preserved. After you click 
Finish, you can pick the insertion point on the layout tab. 

 
One of the terrific benefits of using data extraction to create tables is that as your design 
evolves, your tables are easy to update. 
 

26. On the Model tab, copy some of the furniture a few times somewhere else in the drawing.  
27. On the Layout1 tab, select the take-off table, right-click and choose Update Table Data 

Links. Notice how the count column updates to reflect your changes. 
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FIGURE 23 UPDATE TABLE DATA LINKS 

 
We went quickly through the Data Extraction wizard. Don’t worry, we’ll be doing several more 
exercises and looking more in-depth at some of the settings. But in a nutshell, steps 2 through 4 
of the wizard are about selecting or filtering what data to include in the report. First we identify 
the drawing or drawings, then we select which object types, then we select which specific 
properties or attributes. 
 
In step 5, we refine the data by rearranging, hiding or renaming columns, and applying 
formatting. Step 6 is where we decide where to output to. And step 7 appears when we output 
to a table, and allows us to choose style settings for the table. 
 
 

Exercise #3: Extracting Data Across Multiple Drawing Files 

Reports often need to include information spread across multiple drawings. For example, 
suppose you want to create a Sheet Index that identifies the sheet number and title of all sheets 
(drawings) in your project. Fortunately, Data Extraction handles this quite easily. 
 

NOTE: An index to drawings can be created using Sheet Set Manager, but not everyone 
uses Sheet Sets. If you already use Sheet Sets and that functionality, think of other ways 
you can use this technique to create multi-drawing reports. For example, maybe you are 
designing a multi-story building with each floor in its own drawing. You need to get a 
restroom fixture count across all floors. 

 
1. In Windows Explorer, open the \Multiple folder in your course files. Take a moment to 

open one or more of the files to familiarize yourself with them. 
2. Each drawing in this folder is a different “sheet”—a drawing with a title block. Each 

drawing references one or more files located in the \Multiple\Res folder via xreferences. 
 
For purposes of this exercise, we’re not particularly interested in the xrefs. What we’re after is 
information in the title blocks located on each of the “sheet” drawings. 
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3. Open the T-01 file. 
4. Note that a Sheet Index table exists on the drawing in the lower right corner. We’re going to 

recreate this (as closely as possible) using Data Extraction. 
5. Start the Data Extraction command (Home > Linking & Extraction). 
6. Create a new data extraction file and call it Index to Drawings.dxe. 
7. In Step 2, uncheck Include current drawing, then click the Add Folder button. 
8. Click the … (browse) button next to the Folder box. 
9. Verify you’re in the Multiple folder, then click Open. 
10. Check Automatically include new drawings added in this folder to the data extraction. 
11. Uncheck Include subfolders. 
12. Check Utilize wild-card characters to select drawings. 
13. Enter ?*-*.dwg into the wild-card box. 
 

 
FIGURE 24 ADD FOLDER OPTIONS SETTINGS 

 
There’s a lot going on here. Your path will likely vary from the one shown above (1). When you 
choose the “automatically include new drawings” option (2), AutoCAD will rescan the folder 
anytime you update the data-linked table and add new drawings in. Think about that: a Sheet 
Index that can update itself (or schedules, etc.)! We don’t want to include subfolders (3) in this 
case, but obviously there are situations where you might want this to happen. The “utilize wild-
card characters” option (4) gives us some interesting flexibility. We can choose to include 
drawings only when the file name matches certain patterns. This powerful option warrants a little 
extra explanation. 
 

Understanding Wild-Card Options 
 

We only have two wild-card characters to work with, but we can do some powerful and 
interesting filtering with them. 
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?: Represents any single character (alpha, numeric or otherwise) but expects a 
character to be there. 
*: Represents any number of characters (alpha, numeric or otherwise) but doesn’t 
necessarily expect a character to be there. 
 
Below are a few wild-card patterns and the results when applied to the \Multiple folder. 
 

 
 
From left to right we see: 
 

• ?*-*.DWG: A character (A, S, T, etc.) followed by 0 or more characters, followed 
by -, followed by 0 or more characters, followed by .DWG. This is the pattern for 
our numbered “sheet” drawings, but would not pick up files like “Floor plan.dwg” 
or “Elevation.dwg”. 

• ?-*.DWG: A character (A, S, T, etc.) followed by -, followed by 0 or more 
characters, followed by .DWG. Note that the returned list excludes AS-01.dwg 
because of the extra character (S) in between the A and the -. 

• A*-*.DWG: The letter A, followed by 0 or more characters, followed by -, followed 
by 0 or more characters, followed by .DWG. This excludes all the S- and T- 
drawings. 

 
14. Click OK. 
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FIGURE 25 FOLDER SETTINGS WITH WILD-CARD FILTERING 

 
The figure above shows the folder settings and results of using the wild-card option. If you 
entered the wild-card incorrectly, just right-click the folder and choose Edit Folder Settings… to 
try again. 
 
15. Click Next. 
 

WARNING: You’ll get a message about Drawing Unit Mismatch. This won’t be a problem 
for this exercise, but could be an issue if you were doing an extraction of geometric 
data. In this case, click Yes to continue. 

 
16. Under Display options, uncheck Display all object types and check Display blocks with 

attributes only. This will trim down the list of objects to choose from considerably. 
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FIGURE 26 DISPLAYING BLOCKS WITH ATTRIBUTES ONLY 

 
17. Scroll down until you find the title and Title blocks, and unselect those two. 
 

NOTE: The sample drawings use the same block but in at least one drawing, the block is 
named “title” and in the others it is named “Title”, Data Extraction thinks these are two 
different blocks. No matter, we’ll just include both. 

 
18. Right-click and choose Invert Selection. 
19. Click Next. 
20. In the Category filter, use any technique you want so that Attribute is the only checked 

option. 
21. In the Properties list, use any technique you want so that Sheet_Content1, 

Sheet_Content2 and X are the only checked properties. 
 

 
FIGURE 27 SELECTING TITLE BLOCK ATTRIBUTES 

 
22. Click Next. 
23. Uncheck Show count column, Show name column, and Combine identical rows. 
24. Move column X to be the left-most column. 
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25. Right-click column X and choose Rename column.  
26. Change the name to Sheet Number. 

27. Repeat steps 24-25 to rename column Sheet_Content1 to Title Line 1. 
28. Repeat steps 24-25 to rename column Sheet_Content2 to Title Line 2. 
29. Click the Sheet Number column to sort on that column. 
 

 
FIGURE 28 REARRANGING AND RENAMING COLUMNS 

 
30. Click Next. 
31. Check Insert data extraction table into drawing, then click Next. 
32. Change the Table style to Sheet Index. 
33. Enter the title SHEET INDEX in the box provided. 
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FIGURE 29 TABLE STYLE SETTINGS 

 
34. Click Finish, then select an insertion point in your drawing to place the table. 
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FIGURE 30 SHEET INDEX VIA DATA EXTRACTION (TOP) 

 
As much as I would like to have the table match exactly with the hand-generated table, there 
are some limitations to what we can do. 
 

• We can’t “group” results so that all the A- drawings are under an “Architectural” row, and 
S- drawings are under a “Structural” row. 

• We can’t concatenate the text in one column with the text in another (Title Line 1 + Title 
Line 2), the way we could in Excel. #Sad 

• There’s no way to float the T-01 drawing to the top. 
 
Despite these limitations, you do get a sheet index that can be updated whenever new drawings 
are added to the folder. 
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Bonus Exercise #1 
If you have time, try saving one of the A- drawing as A-06.dwg, then open the new 
drawing and change the attribute in the lower right corner to “A-06”. Also copy one of the 
drawings and save it as Elevations.dwg. Then update your Sheet Index table by right-
clicking and choosing Update Table Data Links. Which drawings appeared on the 
index? Which didn’t  , and why? 
 

Bonus Exercise #2 
Although we can’t “group” the different drawings by type in the table, there is a way we 
can basically get the same result. If you have time, see if you can figure it out. I will give 
you a hint in the form of a screenshot. 
 

 
FIGURE 31 HINT FOR CREATING "GROUPED" TABLES 

 
You’ll have to experiment a bit—or see if I’ve succeeded in stumping my lab assistants 
;). 

 
You can close the T-01.dwg file. 
 

Exercise #4A: Customizing data extraction using sorting, filtering, 
formulas, and totals 

When we use data extraction, we frequently need to do additional things with that data, such as 
sorting or filtering the data, and adding formulas and totals. 
 
1. Open the Landscaping.dwg file. This sample has a site plan from which we want to get the 

square footage of various landscaping materials, represented by hatch objects. 
2. Use the Data Extraction command to start a new dxe file, and name it the same as the 

sample drawing. 
3. In step 3, select Hatch as the type of objects to extract data from. 
4. In step 4, select Area and Layer as the properties to extract. 
 
Step 5 of the wizard we’ve seen before, but this time we want to have our table display the 
summed total of the area of “like” hatch objects (“like” being hatches on the same layer should 
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all be summed together). We also need to convert the area from square inches to square feet, 
and format the output appropriately. 
 
5. In step 5, uncheck Show count and Show name.  
6. Rearrange the columns so Layer is first. 
7. Click on the Layer column header once to sort in ascending order. 
8. Verify that Combine identical rows is checked. 
9. Right-click in the Area column and choose Combine record mode > Sum values. 
 

 
FIGURE 32 SUMMING VALUES IN A COLUMN 

 
10. Right-click in the Area column and choose Set column data format.  
11. Select Decimal and set the precision to 0.  
12. Click on Additional Format, then set the Conversion factor to 0.0069, Suffix to “ s.f.”, and 

set the Thousands separator to ‘,’ (Comma). 
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FIGURE 33 CONVERTING AREA TO SQUARE FEET 

 
13. Click OK twice to return to the Data Extraction wizard. 
 
We’re pretty close, but what if we wanted to exclude hatches on certain layers? For example, 
maybe we don’t want to report the Building footprint. We can accomplish this using Filter 
Options. 
 
14. Right-click the Layer column and choose Filter Options. 
15. Uncheck Building and click OK. 
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FIGURE 34 FILTERING A COLUMN 

 
16. Rename the Layer column as Material. 
 
To see a total of the “landscaped” areas, we need to add a footer row with a formula to sum the 
Area column values. 
 
17. Right-click the Area column and choose Insert totals footer > Sum. 

 

 
FIGURE 35 INSERTING A TOTAL FOOTER 
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18. Click Next, and insert a data extraction table with the title “LANDSCAPING MATERIALS” 
into the drawing. 

 

Exercise #4B: Linking Excel spreadsheets with AutoCAD data 

A common workflow in many offices is to enter tabular data into an Excel spreadsheet. 
Frequently this data needs to be displayed in CAD drawings as well. For that, we can link a 
table in AutoCAD with a “Data Link” to an Excel table. That’s good for getting information into 
our drawing, but this lab is focused on leveraging data already in our drawings. It turns out that 
we can do a hybrid approach, combining data from our drawings, with data in a spreadsheet, 
and outputting the combined data to a table in our drawing. 
 
In exercise 4A, we created a landscaping materials table using hatch areas from our drawing. 
Let’s link this data to cost data coming from an Excel spreadsheet to calculate our total 
estimated costs for the project. 
 
In your sample files folder is an Excel file named Landscaping Costs.xlsx. Your task is to add a 

Cost column to the Landscaping Materials table you created, but data-linked from Excel. Once 
you have that linked, you’ll insert a formula column that multiplies the Area * Cost to provide the 
Total Cost for each material. 
 

TIP: In order to calculate the Area column, we have to make the column value numeric. 
So you’ll need to edit the Area column and remove the suffix we added previously. You 
can rename the column to Area (s.f.) so the point gets across. 

 
1. Select any cell in the LANDSCAPING MATERIALS table you created in Exercise 4A, the 

choose Data Extraction > Edit Data Extraction Settings. 
2. Click Next until you arrive at Page 4 of 7 (where you see the preview of the data). 
3. Right-click the Area column and rename it Area (s.f.). 
4. Right-click the Area (s.f.) column, and choose Set column data format. 
5. Click Additional Format. 
6. Remove the Suffix we input earlier, then click OK twice. 
7. Click Link External Data. 
 

 
FIGURE 36 LINKING EXTERNAL DATA 

 

8. Click Launch External Data Manager . 
9. In Data Link Manager, click Create a new Excel Data Link. 
10. Enter Landscaping costs as the name of the data link. 
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FIGURE 37 CREATING A DATA LINK 

 
11. Click OK. 

12. Click the Browse button . 
13. In the course files folder, select Landscaping Costs.xlsx and click Open. 
14. Under Link Options, verify that Sheet1 is selected, then click OK. 

 

 
FIGURE 38 EXCEL DATA LINK 

 
15. Under Excel Links, verify that Landscaping Costs is selected, then click OK. 
16. Under Drawing data column, select Material. 
17. Under External data column, select ID. 
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18. Click Check Match. 

 
FIGURE 39 IDENTIFYING KEYS 

 
Identifying these “keys” is crucial for getting the external data to link up. Your Excel file must 
contain unique values in the external data column--“ID” in the example used here. AutoCAD 
matches this up with a value you identify as the drawing data column--“MATERIAL” in the 
example shown here, which is the renamed column representing the layer names in the 
drawing. 
 
19. Click OK. 
20. Verify the Cost per S.F. box is checked, and uncheck the ID column. 
21. Click OK. 
 
Back in page 4, you’ll see a preview of the newly added Cost per s.f. data. Now let’s add a 
formula to calculate the total cost. 
 
22. Right-click the Cost per S.F. column and choose Insert Formula Column. 
23. Enter Total Cost as the Column name. 
24. Double-click Area (s.f.) then click the Multiply button, then double-click Cost per S.F. then 

type in the box: / 144. 
 

EEK! Major error here that was pointed out to me in class. The underlying Area value is 
in the drawing’s units (inches), not the reported value of the Area (s.f.) column which 
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has a calculation applied via the Additional Format we applied earlier. Here, we need to 
divide by 144 to get a valid result. 
 
 

 

 
FIGURE 40 INSERT A FORMULA COLUMN 

 
25. Click OK. 
26. Insert a totals footer to sum the Total Cost column. 
27. Right-click the Total Cost column and choose Set column data format. 
28. Set the Data type to Currency, the Precision to 0, then click OK. 

 
NOTE: As I was preparing this exercise, the wizard threw an error if I set the format to 
currency before adding the totals footer to the Total Cost column. It may have been a 
fluke, but adding the totals footer first, then applying the format seemed to work better 
for me. 
 

29. Click Next until you get through the wizard, then click Finish. 
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FIGURE 41 COMPLETED TABLE WITH LINKED COST AND CALCULATED TOTALS 

 

Exercise #5: More Linking Excel spreadsheets with AutoCAD data 

If we have time, I wanted to give you one more chance to practice linking Excel spreadsheets 
with AutoCAD data. In this exercise, we’ll use an Excel file listing standard architectural 
keynotes and descriptions, and an AutoCAD drawing containing keynote “bubbles” identifying 
various materials. We’ll then create a table containing a KEYNOTES schedule that is specific to 
the drawing—only the keynotes actually called out on the drawing appear on the schedule. 
 
1. In the course files, open the \Keynotes\CSI.xlsx file in Microsoft Excel. This file contains a few 

items from the CSI MasterFormat® catalog. 
2. Note the ID column contains unique entries. These can be numeric or alphanumeric, they 

just have to be unique. The Description column contains a material description 
corresponding to the key with which it is associated. 

 

 
FIGURE 42 EXCEL FILE CONTAINING CSI KEYNOTES 

 
3. Close the CSI.xlsx file. 
4. Open the Keynote Sample.dwg file in that same folder. The drawing contains a section 

through part of a wall, with a few items called out by CSI number. 
 



 
 

 

Page 31 

 
FIGURE 43 KEYNOTE SAMPLE DRAWING 

 
The point of this exercise is to build a sheet-specific Keynotes table, showing the description 
(from the Excel file) corresponding to the callouts actually used in the drawing. 

 
5. Start the Data Extraction wizard, and create a new data extraction file named 

Keynotes.dxe. 
6. Select the Keynote block in step 3. 
7. Select the Keynote attribute in step 4. 
8. In step 5, do the following: 
9. Uncheck Show count column and Show name column. 
10. Click the Link External Data button. 
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FIGURE 44 LINKING EXTERNAL DATA 

 

11. Click Launch Data Link Manager . 
12. Click Create a new Excel Data Link and enter the name CSI. 
13. Browse to the sample files directory and select CSI.xlsx. 

14. Verify that Sheet1 is selected and Link entire sheet then click OK twice. 
 

 
FIGURE 45 EXCEL DATA LINK 

 
15. Select KEYNOTE in the Drawing data column and ID in the External data column, then 

click Check Match. 
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FIGURE 46 DATA MATCHING 

 
Identifying these “keys” is crucial for getting the external data to link up. Your Excel file must 
contain unique values in the external data column (“ID” in the example used here). AutoCAD 
matches this up with the value you identify as the drawing data column (“KEYNOTE” in the 
example shown here). 
 
16. You can select any additional columns from your Excel file to add to any data you’re 

extracting from AutoCAD itself. 
17. Click OK to return to step 5. 
 

 
FIGURE 47 LINKED COLUMNS 

 
18. Rename the ID column to Key and sort on that column. 
19. In step 6, select Insert data extraction table. 
20. In step 7, enter KEYNOTES as the title for your table. 
21. Finish the wizard and insert your table. 
 
You can close the Keynote Sample.dwg when you are finished. 
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FIGURE 48 FINISHED DATA-LINKED TABLE 

 

Bonus Exercise #3 
Do we still have more time? Great! Let’s build a room schedule, then look at what needs 
to happen when we add an attribute to the block upon which our data extraction 
depends. 
 
1. Open the Floor Plan Sample.dwg we used earlier in the lab. 
2. Create a layer named Schedules and make it the active layer. 
3. On the ribbon, go to Insert > Linking & Extraction, then click Extract Data. 
4. Create a new data extraction named RoomSchedule.dxe. 
5. In step 3, select only the RMNUM block. 
6. In step 4, select only the NUMBER attribute. 
7. In step 5, do the following: 
8. Uncheck the Show count and Show name column boxes. 
9. Click on the NUMBER column to apply sorting (6001 should be at the top). 
10. Insert the data extraction table into the drawing, with a table title of ROOM 

SCHEDULE. 
 

If you started the data extraction command in modelspace, the table will be quite small. 
We’ll deal with that in a few minutes. While functional, our room schedule leaves a bit to 
be desired. First, it’s a very lengthy table that will be hard to fit on paper when we print 
this out. Let’s take advantage of table breaking to help us out. 

 
11. Select the table. 
12. Using the grip at the very bottom middle of the table, drag up until you’ve created 

three roughly equal columns. 
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FIGURE 49 RESIZING THE TABLE 

 
13. Select the table, right-click and choose Properties, then set the Repeat top labels 

property to Yes. 
 

 
FIGURE 50 REPEATING COLUMN LABELS 

 
The second problem with our Room Schedule is that there just isn’t very much 
information available. Seems like it would be more useful if we could see who is 
assigned to each room. However, that attribute was not available on the RMNUM block. 
Let’s update the block definition to carry more useful data. 
 
14. Zoom out so you can see the floor plan, then locate one of the RMNUM blocks. 
15. Select the block, then right-click and choose Block Editor. 
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FIGURE 51 EDITING A BLOCK DEFINITION 

 
16. Copy the NUMBER attribute and paste a copy below the rectangle. 
17. Double-click the new attribute and set the Tag to “Occupant”, Prompt to “Name of 

Occupant” and Default to “-”, then click OK. 
18. Select the attribute, right-click and choose Properties. 
19. Set the Invisible property to Yes. 
 

 
FIGURE 52 ADDING AN ATTRIBUTE TO A BLOCK DEFINITION 

 
Of course, it may be useful to have the Occupant attribute displayed on the drawing. 
This would make having the “extra” text version on the drawing obsolete, and the 
approach I would likely use myself. Here though, I want to demonstrate that attributes 
don’t have to be visible on the drawing to be extractable. 
 
20. Click the Close Block Editor button then choose Save changes. 
21. Double-click one of the RMNUM blocks to edit the attributes. 
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FIGURE 53 WHERE'S THE NEW ATTRIBUTE? 

 
Wait. Shouldn’t there be two attributes now? Whenever you add or remove attributes 
from a block which has already been inserted into the drawing, you need to use the 
ATTSYNC command to synchronize any existing block references with the attributes in 
the block’s definition. 
 
22. Click Cancel to exit the Attribute Editor, then go to Insert > Block Definition, then 

click the Block Definition drop-down, then choose Synchronize (or type 
ATTSYNC). 

 

 
FIGURE 54 SYNCHRONIZE AFTER ADDING NEW ATTRIBUTES TO EXISTING BLOCKS! 

 
23. Choose Select, then select a RMNUM block, then select Yes. 
24. Double-click one of the RMNUM blocks again and you should see the new attribute 

available for editing. 
 

 
FIGURE 55 NEW ATTRIBUTE APPEARS AFTER SYNCHRONIZE 
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Take a few minutes and add the occupant name (red text in the room) to the Occupant 
attribute of several RMNUM blocks. You don’t need to do them all, but do several so we 
can see them on the Room Schedule table. 
 
We now need to update our Data Extraction (dxe) file to include the new attribute we just 
added. 
 
25. Select the ROOM SCHEDULE table, then select one of the cells within the table.  

 
For some reason, this allows the Data Extraction submenu to appear when we right-
click, whereas it does NOT appear if the whole table is selected.  

 
26. Right-click and choose Data Extraction > Edit Data Extraction Settings…. 

 

 
FIGURE 56 EDIT DATA EXTRACTION SETTINGS 

 
27. Click Next until you get to step 3. 
28. Check the Number and Occupant attributes, then click Next. 
29. Click the Full Preview button to see a preview of your table. Close the preview when 

you’re finished. 
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FIGURE 57 DATA EXTRACTION PREVIEW 

 
30. Right-click the NUMBER column and choose Rename Column, then change the 

column name to ROOM #. 
 

 
FIGURE 58 CHANGING COLUMN NAMES 

 
31. Click Next through the wizard, then click Finish. 
32. Adjust the columns again so there are only three, as before. 
33. Adjust the column widths by selecting the table, then clicking and dragging the 

column width grip, as shown below. 
 

 
FIGURE 59 UNIFORMLY RESIZE COLUMN WIDTHS 

 
Unfortunately, the row heights don’t automatically adjust. 

 
34. To resize the row heights, select the rows that are too tall, then right-click and 

choose Properties. 
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35. Set the Cell height to something very small (like 0.1”). AutoCAD will set the height 
as small as possible while still fitting the text + the specified cell margin. You may 
need to do this a few times to “reset” any affected rows. 

 

 
FIGURE 60 TRICKING AUTOCAD INTO AN ACCEPTABLE ROW HEIGHT: BEFORE (LEFT), AFTER (RIGHT) 

 

Summary 

We’ve covered a lot of ground in this lab. You’ve learned: 
 

• How to use the Data Extraction command to build updateable reports for things like 
material take-offs;  

• How to extract data from multiple drawings to generate Sheet Index reports;  

• How to link AutoCAD and Excel data into a combined report,  

• How to link text fields to geometric data that updates when your drawing does. 
 
I hope your mental gears are spinning, thinking of ways you can go home and apply your new 
mastery of the Data Extract command to tasks in your industry. 
 
If you have any questions about this course, please feel free to contact me at 
ben@leadensky.com. 
 


